Advanced Webinar: Investigating Time Series of Satellite Imagery
Apr 15 & 17, 2019

Exercise 1: Extracting MODIS Time Series Data Using
AppEEARS

Objectives

e Identify appropriate MODIS images for comparison with point and polygon data
e Use web-based tool to select and download MODIS data
e Visualize time series results and assess data quality

Analyze and interpret time series data

Overview of Topics

e Extract point and polygon samples from MODIS data in AppEEARS
e Explore results in AppEEARS

e Download results and analyze in Excel

e Visualize results

Software/Tools Needed

e Please sign up for a free NASA Earthdata account:
https://urs.earthdata.nasa.gov/users/new
e Microsoft Excel

Associated Data

e Beetle.csv file -This file is a list of point locations in Colorado where beetle
infestation has cause forest mortality

e SQUARE_ID17QK09.zip — This is a zipped shapefile of a polygon from the
Ontario Breeding Bird Atlas

All associated data must be downloaded from the ARSET website here:
https://arset.gsfc.nasa.gov/land/webinars/time-series-19
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Infroduction

For this exercise, we will explore the Application for Extracting and Exploring Analysis
Ready Samples (AppEEARS) for assessing time series of MODIS imagery. For this
exercise, we will examine MODIS time series data that coincide with point data where
forest disturbance has occurred. The Application for Extracting and Exploring Analysis
Ready Samples (AppEEARS) allows users to conduct web-based analysis without the
need to download MODIS datasets. We will use point locations of beetle infestation to
analyze vegetation patterns from MODIS NDVI data from 2002 — 2018 within
AppEEARS and Excel. In the western U.S. mountain pine beetle disturbances have
been extensive, particularly in the has been Arapaho-Roosevelt National Forest. We will
examine seven point locations that have been affected by the beetle infestation.

Google Earth

The figure above shows the location of the seven sites we will analyze in this exercise.
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Here you can see sites B1 and B2, and you may notice these forested regions have a
red/brown hue to them, indicative to beetle infestation.

Part 1: Analyzing Vegetation Disturbance with Point Data

1. Go to the AppEEARS homepage https://Ipdaac.usgs.gov/tools/appeears/ and
click on Launch

2. Sign in using your NASA Earthdata login

3. From the top panel, select Extract > Point Sample

Extract Explore

Area Sample

Point Sample

4. Click on Start a new request

Under Enter a name to identify your sample, type in Beetle 1.

6. Under Upload coordinates from a file you can either drag your .csv file into the
box or you can click to upload it. Note the required format of the CSV file. It can
contain up to 4 columns separated by commas with each coordinate on a

o
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separate line. Upload Beetle_CO.csv. You will see it appear under Uploaded
coordinates to the right.

7. To set the date, check the Is Date Recurring box. Then set the Start Date to
MM-DD by clicking on the date box to the right. To change the month, click on
the arrow pointing left until you reach June. Then, select June 1. Repeat for the
End Date and put June 30.

8. Under Year Range move the blue dots on the time slider to 2002 — 2018

Enter a name to identify your sample

Beetle 1
Upload coordinates from a file Uploaded coordinates (ID, Category, Lat, Long): 7
' T N SN S NN N RN O RN D NN N NN N SN N SN N W N M N W .
1 1 B1, 40.083928, -105.850244
i Drop a CSV file containing the coordinates or click here to select the 1 B2, 40.095886, -105.8297
: file. Coordinates can also be entered manually in the uploaded : B3, 40.15821, -105.772138
I coordinates box. ' B4, 40.188223, -105.770775
]
§ The CSV file can contain up to 4 columns separated by commas with : B, 40.250526, -105.781057
B each coordinate on a separate line. ] B6, 40.284788, -105.829178
] '] B7, 40.243185, -106.089549
i 1. ID (optional) - uniquely identifies the coordinate ]
: 2. Category (optional) - label to group common coordinates :
1 3. Latitude - latitude in decimal degrees (-90 to S0) i
] 4. Longitude - longitude in decimal degrees (-180 to 180) ]
1 ]
W o ’
Start Date End Date ©

06-01 06-30

Hudson

B:
Year Range: 2002 - 2018 i

Is Date Recurring?

; United
States
“of America
¥

s

Mexico

»Leaflet | NASA EOSDIS GIBS

Add coordinates using the @ tool. View coordinate details by clicking the markers on the map

9. Scroll down until you see Select the layers to include in the sample
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10.In the Search for a product box, type vegetation. You will see several MODIS

products appear. Select Terra MODIS Vegetation Indices (NDVI & EVI)
MOD13A3.006

Select the layers to include in the sample &

vegetation

Terra MODIS Vegetation Indices (NDVI & EVI)
MOD13A1.006, 500m, 16 day, (2000-02-18 to Present)

Terra MODIS Vegetation Indices (NDVI & EVI)
MOD13A2.006, 1000m, 16 day, (2000-02-18 to Present)

Terra MODIS Vegetation Indices (NDVI & EVI)
MOD13A3.006, 1000m, Monthly, (2000-02-01 to Prasent)

Terra MODIS Vegetation Indices (NDVI & EVI)
MOD13Q1.006, 250m, 16 day, (2000-02-18 to Present)

Terra MODIS Vegetation Continuous Fields (VGF)
MOD44B.006, 250m, Yearly, (2000-03-05 to 2016-12-31)

11.Several options will appear in the box below. Select 1_km_monthly NDVI by
clicking on the + to the right. That will add it to the Selected Layers box on the

Select the layers to include in the sample & Selected layers
Terra MODIS Vegetation Indices (NDVI & EVI) x 1000m,
MOD13A3.006, 1000m, Monthly, (2000-02-01 to Present) © _1_km_monthly_NDVI Monthiy =
@ _1_km_monthly_EVI +
@ _1_km_monthly_MIR_reflectance +
@ _1_km_monthly_NIR_reflectance +
@ _1_km_monthly_VI_Quality +
~Sor
right.

12.Click Submit. Once you do that, a message will appear at the top that says “The
point sample request was successfully submitted. An email notification will be

delivered once the request is complete.” You will also get an email confirming
your request.
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13.To check the status of your request, you can click on the Explore tab at the top
of the page. The length of time for an AppEEARS request to process is
dependent on a number of factors including size of the request and server traffic.

You will receive an email from LP DAAC once the request is complete. Next, we will
explore the results of the point sample request using visualizations in AppEEARS

14.0nce the processing is complete, view it in the Explore Requests tab. Click on
your request: Beetlel.

15. Another page will appear called View Point Sample. The first tab is Temporal
Comparison. This allows you to look at the time series for a single point.

View Point Sample
Request: Beetle 1

Temporal Compatison Layer Comparison Categorical Overview

Site: B1, 40.083928, -105.850244 %
Quality: Show All ;0

Layer: MOD13A3_006__1_km_monthly_NDVI 5| €@
B1, 40083928, -105.850244

Leafist | NASA EOSDIS GIBS
Select a site and view coordinate details by clicking the markers on the map.

Time Series

Dates Selected: All " AddLine @~

LLE [
06
0.6 L

06 ™

06 °
06 ®
0.6 ®
osd
05 .
as ® ]

054 a ®

1_km_monthly_NDVI

L

T T T T T T
2004 2006 2008 2010 2012 2014 2016

T T T T T T
2004 2006 2008 2010 2012 2014 2016

Stacked Time Series

M z002 2003 2004 2005 M z2008 2007 M zc08 2009 Wz010 2011 Wz012 2013 2014
2015 Wzo016 2017 2018

16.In the Site dropdown list, keep the default (B1, 40.083928, -105.850244)
17.1n the Quality dropdown list select Show Good Quality
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18.In the Layer dropdown list, keep the default
(MOD13A3 _006_1 km_monthly_NDVI)

19. Scroll down until you can see the Time Series graph. Click Add Line on the top
right.

Time Series
Dates Selected: [06-01-2002 to 06-01-2018] Reset AddLine @~
064
Q.64
064

ly_NDVI

0.6
06
0.6
06

0.5
0.5

_1_km_monthl

0.5+

0.5

T T T
2004 2006 2008 2010 amz 2014 2016 2018

T T T T T T T T
2004 2006 2008 2010 2mz2 2014 2016 2018

The Time Series graph shows NDVI values for the B1 point for 2002 — 2018, which
varies between 0.5 and 0.6. Each point represents a MODIS NDVI value for the monthly

composite observations in June. You can get the exact NDVI value by placing your
mouse over a point.

20.Go back to the Site dropdown box and look at a few more points (B2— B7).

Looking at this graph you will notice the large decrease in NDVI values between 2006
and 2008, which is when the beetle infestation resulted in extensive forest mortality. As

the forest recovers, you can see a slow increase in NDVI values between 2010 and
2018.

21.Scroll to the top of the page and click on the Categorical Overview tab.
22.Scroll down until you can see the Quality graph. This graph shows how many
satellite pixels had Quality 0 (Good quality) and Quality 1 (questionable quality).
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Put your mouse over the Quality 1 box (orange) and you will see that there are 3
pixels with questionable quality (n=3)

Quality ©

0.6

064

0.6

0.60
06

0.6

y_NDVI

0.5

0.54
0.5

05+

0.49

0.5

_1_km_monthl!

05+

H < 0.45
LEE H

0.4+

0.4

23.Scroll down until you see the Sites graph. This graph shows you the mean and

range of NDVI values for each site. Put your mouse over each box to see those
values.

Sites

0.6

: 063 —_—
0.6 - : ' T :

06

0.6 | 0.58

' —_—
0.6+ 1 . E

0.5 T '

0.5 B L 0.53 H

0.5

y_NDVI

0.50 H

0.5

1_km_monthl

R

0.5

04

0.4

0.4

24.To include only good quality pixels in the Sites graph, go back up to the Quality
graph and click on the blue box, for value 1. That will turn off the orange box and
only include pixels with good quality in the Sites graph. When the pixels with a

Quality = 1 are removed from the Sites graph, the orange box-and-whisker will
turn grey.
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Download the Data & Analyze in Excel

25.Click on Explore at the top of the window

26.0n the far right of your Beetle 1 request, click the download button ﬂ
The Download Point Sample page will appear. Under the Select section, click
on your results: Beetle-1-MOD13A3-006-results.csv. A zip file will download to
your computer.

Select: All |

Name

@ Beetle-1-MOD13A3-006-results.cav

27.1n Excel, open Beetle-1-MOD13A3-006-results.csv.

This .csv file has many columns. The first thing we want to do is filter the results so we
are only working with good quality pixels.

28.0n the top of the Excel window click on Data > Filter. You will see dropdown

boxes appear next to all your Row 1 headings =

29.Go to Row N and click on the dropdown box. Click off Decreasing quality
(0010), Decreasing quality (0011), and Lower Quality. You may need to
increase the size of the filter window to see the Lower Quality option. Only
Highest quality should be selected.
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N |

MOD13A3_006__1_km_monthly_WI_Quality_VI_Usefulness_Description |£

Highest quality
Highest quality
Highest quality
Highest quality
Highest quality
Highest quality
Highest quality
Highest quality
Highest quality
Highest quality
Highest quality
Highest quality
Highest quality
Highest quality
Highest quality
Highest quality
Highest quality
Highest quality
Highest quality
Highest quality
Highest quality
Highest quality
Highest quality
Highest quality
Highest quality

[ E TP T

£} MOD13A43_006_1_km_monthly VI_...
Sort
2.3 Ascending

2} Descending
By color:

Filter
By color:
Equals » Highest quality
And Cr

Choose One 5

(Select All)

Decreasing quality {0010)
Decreasing quality (0011)
Highest quality

Clear Filter

30. Select the entire spreadsheet (by clicking on the triangle on the top left), and
copy and paste into a new Sheet.
e You can add a new sheet by clicking on the “+” icon at the bottom of the Excel

page.

31.Name this new sheet NDVI1, and save the entire file as Beetlel.xIsx
e On the new sheet, ensure all the rows in column N are labeled as Highest

quality.

32.We only need columns A (ID), D (Date) and H
(MOD13A3 _006_1 km_monthly NDVI), Delete all other columns.

The excel sheet should now contain three columns. The ID represents the pixel where
you have a point (B1 to B7, since there are seven sites). For each location, there should
be a NDVI value for June 1%t of each year from 2002 to 2018. As you scroll down the
sheet you will notice some of the points have missing years. To easily visualize the
data, you will need to add the missing years but you should leave the value cell empty.
For example, point B2 is missing 2015.

http://arset.gsfc.nasa.gov/
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33.For each missing data point, add a row and insert the ID and the missing date.

Here are the dates missing:
e Site B2: 6/1/2015
e Site B3: 6/1/2011
e Site B3: 6/1/2007
e Site B3: 6/1/2018
e Site B4: 6/1/2003
e Site B4: 6/1/2005
e Site B4: 6/1/2011
e Site B4: 6/1/2017
e Site B5: 6/1/2005
e Site B5: 6/1/2008
e Site B5: 6/1/2011

e Site B6: 6/1/2007

34.We will need to reformat the spreadsheet in order to graph the data. Add a new
sheet by clicking on the “+” icon at the bottom of the Excel page, and name it
NDVI2.

35. We need each pixel (B1 to B7) to be separated into distinct columns. Open
another sheet and in the cells in Row 1 type each label into a consecutive
column:

e Column A: Date
e Column B: B1
e Column C: B2
e Column D: B3
e Column E: B4
e ColumnF: B5
e Column G: B6
e Column HL: B7

36.From Sheet 1, copy and paste the dates 6/1/2002 through 6/1/2018 into Column
A. Then copy and paste the NDVI values for each point (B1 through B7) into the
appropriate columns on Sheet 2.
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The newest tab on your spreadsheet should now look like this:

A B L D E F G H
1 |Date B1 B2 B3 B4 BS B6 B7
2 6/1/02 0.5438 0.6044 0.5349 0.6012 0.5438 0.618 0.5324
3 6/1/03 0.5754 0.6313 0.6269 0.5627 0.6228 0.5245
4 6/1/04 0.5912 0.6474 0.5383 0.6147 0.6063 0.6282 0.583
5 6/1/05 0.6117 0.6149 0.6061 0.6 0.5305
6 6/1/06 0.6177 0.6259 0.5766 0.5795 0.6085 0.6189 0.5474
7 6/1/07 0.5587 0.5328 0.5269 0.5472 0.4546
8 6/1/08 0.508 0.5072 0.4814 0.5112 0.503 0.4226
9 6/1/09 0.5247 0.4517 0.388 0.4726 0.5561 0.5575 0.4892
10 6/1/10 0.5061 0.5095 0.5271 0.4885 0.4731 0.5278 0.425
11 6/1/11 0.5401 0.5559 0.5356 0.4378
| 12 6/1/12 0.5254 0.5721 0.4751 0.4553 0.5169 0.5507 0.4889
| 13 6/1/13 0.5123 0.5327 0.5226 0.4562 0.4874 0.5219 0.4253
14 6/1/14 0.5333 0.539 0.4957 0.4557 0.4813 0.5397 0.4537
15 6/1/15 0.5656 0.5469 0.5259 0.5633 0.5831 0.5117
16 6/1/16 0.5513 0.5589 0.5567 0.6271 0.5467 0.5827 0.4756
17 6/1/17 0.5744 0.5519 0.6158 0.5219 0.5801 0.4713
18 6/1/18 0.5189 0.5287 0.5046 0.5065 0.5809 0.4534
19
20
21
< > Beetle-1-MOD13A3-006-results.cs | NDVIL | NDVIZ | +
Y
Mormal View Ready

37.Now you can graph the points and compare them to each other. To compare the
first 3 points, select Columns A-D and Rows 1-18.

38. At the top of the Excel page, select Insert > Chart > Scatter > Straight Marked
Scatter

39.The graph will appear next to the data. We would like to improve the graph by
changing the range of the values on the Y-axis. Right-click on the Y-axis and
select Format Axis. Next to the Minimum Bounds box, change 0.0 to 0.35. Click
OK.
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Format Axis
Scale
Number Vertical axis scale
L. Ticks Auto
i Font | Minimum: 0.34
T| Text Box
. Maximurn: 0.7
i
“\, Line Major unit: 0.05
&) Shadow Miner unit: 0.01
() Glow & Soft Edges
Horizontal 035
axis crosses at:
Display units: | None B Show display units label on chart
| Logarithmic scale Base: 10.0
| Values in reverse order
" Horizontal axis crosses at maximum value

Cncel (I

Now your graph should look like this:
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Notice the decrease in NDVI values for each of the sites (B1 to B3) from about 2006 to
2009. You can also repeat step 34 for all of the sites or any specific sites you may be
interested in viewing.

http://arset.gsfc.nasa.gov/ 13



http://arset.gsfc.nasa.gov/

Advanced Webinar: Investigating Time Series of Satellite Imagery
Apr 15 & 17, 2019

Part 2: Using Polygons to Create Remote Sensing-derived
Environmental Descriptors

This portion of the exercise is based on a methodology from Coops et al., 2009, that
used remote sensing-derived environmental descriptors of topography, land cover, and
vegetation productivity to predict species richness of breeding birds in Ontario, Canada.
To quantify avian biodiversity, they used bird statistics provided by the Ontario Breeding
Bird Atlas (OBBA) project. The OBBA data are divided into 10 x 10 km cells. The
authors combined the bird statistics with the following environmental descriptors derived
from remote sensing data from 2000 — 2005.

Here we will be deriving the same or similar environmental descriptors from MODIS
2001 — 2005 imagery using AppEEARS for one of the 10 x 10 km cells including:

e Variation in topography (calculated as the coefficient of variation)
e Land cover
o Dominant land cover class
o Land cover dominance (percentage of the area covered by the dominant
class
o Land cover richness (total number of land cover classes within the cell)
e Vegetation dynamics
o Total annual productivity — derived by summing monthly productivity for
each year and then averaging over the total period of time.
o Minimum level of perennial cover (seasonal greenness)
= Relates to the potential of the landscape to support populations
throughout the year.
= Derived by calculating the annual minimum monthly NDVI and
averaged over the total time period
o Degree of vegetation seasonality (annual minimum cover)
e Derived by calculating the coefficient of variation (CV) for
NDVI. High CV values indicated seasonal extremes in
climatic conditions, while low CV values typically represent
irrigated pasture, barren land or evergreen forests.

1. If you are not already logged in, go to the AppEEARS homepage
(https://lpdaacsvc.cr.usgs.gov/appeears/) and sign in using your NASA Earthdata

login.

http://arset.gsfc.nasa.gov/ 14
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2. From the top panel, select Extract > Area Sample

3. Click on Start a new request

4. Under Enter a name to identify your sample, type OBB1

5. Under Upload a file, drag and drop SQUARE_ID17QK09.zip. You will see the
polygon appear on the right.

6. Set Start Date to 01-01-2001 and End Date to 12-31-2005

7. Keep “Is Date Recurring” unchecked

8. Under Select the layers to include in the sample choose the following layers from
these products.

e You can find the products by typing in the product name in the search and
selecting the appropriate data product. Make sure you click on the + next to
the Layer to add it to the Selected Layers list on the right.

e If you begin to type in the product name (in parenthesis below) the list will
automatically generate the layer options. Then you can click on the specific
layer to add it to the Selected Layers list. After you have added a layer, use
the “x” in the product name to close that option.

Data Product Layer

Vegetation Indices (MOD13A3.006) _1 km_monthly_NDVI
Net Primary Production Npp_1lkm
(MOD17A3.055)

Land Cover Type (MCD120Q1.006) LC_Type2

Digital Elevation Model Bandl
(SRTMGL1.003)

9. Scroll down to Output Options
e File Format: GeoTIFF
e Projection: Geographic
e Click Submit
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Enter a name to identify your sample

0BB1
Upload a file or draw a polygon using the & or M icon Selected file (SQUARE_ID17QK09/SQUARE_ID17QK09)
- e Em Em Em o Em E E S B BN B Ee Ee Em Em
| 1
1 Drop a vector polygon file containing the area feature(s) to extract or 1
click here to select the file.
1 Supported file formats: 1
I * ESRI Shapefile (.zip inciuding .shp, .dbf, .prj, and .shx files) I
1 * GeoJSON (json or .gecjson) 1
| ]
- e mm Em Em Em Em o Em o o o Em Em Em Em oEm oEm =
Start Date End Date ©
01-01-2001 12-31-2005 iz
~| Is Date Recurring?
To clear a polygon, draw a new polygon or upload a vector polygon file.
Select the layers to include in the sample €& Selected layers
SATM Elevation x 1000m,
SRTMGL1.008, 30m, Static, (2000-02-11 to 2000-02-21) © _1_km_monthly_NDVI Monthly -
There are no layers available for this product. © Npp_1km 10001 Terra MODIS Vege
€& LC_Type2 500m, Yearly =
€ Bandl 30m, Static =~ =

Output Options

File Format: GeoTitf  [§
Projection:

NOTE: Be aware that any reprojection of data from its source projection to a different projection will inherently change the data from
its original format. All reprojections use GDAL's= gdalwarpe function in combination with the PROJ.4 = string listed above. For
additional information, see the AppEEARS help documentation.

o
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10. After your request has been submitted, click on the Explore tab to view submission
progress

11.0nce the request is complete, click on OBB1

12.In the Stats tab, set the Layer to MCD12Q1 006 _LC_Type2. This is the land cover
data.

13. Scroll down to Layer Stats. Put your cursor over the orange box above the first date
01-01-2001. You will see:

e Category: Deciduous Broadleaf Forests, Value: 4; Count: 378 (54.3%), Date:
01-01-2001

Layer Stats

Category: Deciduous Broadleaf Forests
Value: 4
Gount: 378 (54.3%)

Date: 01-01-2001

Pixal Count

14.Do the same for the green and red boxes. For this OBBA tile, the dominant land
cover type is “Deciduous Broadleaf Forests”

15. Scroll back up to the top. Under the Layer dropdown, select
MOD13A3_006__1 km_monthly NDVI
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16. Scroll down to Layer Stats. This shows the distribution of NDVI over the 5-year time
period for the tile.
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17. Click on the Zoom to Year icon on the top right and select 2001. Now you can see
the yearly phenology of this region more clearly.
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18. Along the bottom of the Layer Stats graph, move the highlighted window to include

2003. You can modify this feature to select specific years of interest within the entire
time period.

Layer Stats
Dates Selected:[01-01-2001 to 01-02-2003] Reset it @~
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19. Scroll down to view the QA Stats for the NDVI data. Use your mouse to hover over
each section in the bar chart you will see information about the date, the quality and

the number of pixels with that quality. The purple bars show the highest quality
pixels.

20.Hover your mouse over the first blue bar above 01-01-2001. You will notice that 51
pixels have “Decreasing quality” for this date.
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Quality Value: 20487

Count: 51 (29.33%)
Date: 01-01-2001

MODLAND: VI procuced, but check other QA QA Stats for _1_km_monthly_VI_Quality
V1 Usefulness: Decreasing quality (0100

Asrosol Quantity: Climatology
Adjacent cloud detectad: Mo

Atmosphere BRDF Mo
‘Cormrection:

Mixed Clouds: No

Land/Water Mask: Ocean coastines and lake
shorelines

Possible snowfice: Yes

Possible shadow: Mo

21.Go back to the top of the window and click on Explore. To far right of your request,
select the download button.

03-06-2019 03-06-2019
OBB1 (BT LE goos o 11:01:48 am CST 11:02:12 am ST n B ﬂ

22.For this exercise we will only be using the statistics files. Note that if you scroll down

to the selection box (where it says 0 Selected), you can download the MODIS data
associated with this tile in a .tif format. Download the following statistics files and
save them to your Time Series Exercisel folder:

e MCD12Q1-006-LC-Type2-Statistics.csv

¢ MOD13A3-006-Statistics.csv

e MOD17A3-055-Statistics.csv

e SRTMGL1-003-Statistics.csv

These files contain statistics associated with the request including minimum/maximum,
mean, standard deviation, and variance of the pixel values from the region of interest for
each observation. For categorical layers like Land Cover Type, frequency distributions
are returned in the statistics files.

Calculate Statistics for Land Cover Classes

23.0pen the MCD12Q1-006-LC-Type2-Statistics.csv file in Microsoft Excel
24.Insert a new column after Column C (Date), labeled ‘Dominant Land Cover’
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25.To select the dominant land cover type for 2001, enter the following formula in cell
D2: =INDEX($E$1:$1$1,0, MATCH(MAX($E2:$12),$E2:$12,0)). Click Enter to apply

the formula.
fx| =INDEX(SE51:51% 1,D.MATCH[MA)((SE2:SIZJ,SE2:SI2,DJ)|
[ | D E E G H 1

Date Dominant Land Cover 0) Water Bodies (4) Deciduous Broadleaf Forests | (5) Mixed Forests | (8) Woody Savannas | (13) Urban and Built-up LandsI
L 1/1/01 [MAX(SE2:512),5E2:512,0)) 8 378 295 9 &l
L 1/1/02 8 379 251 12 &
L 1/1/03 B 377 293 12 &
L 1/1/04 8 380 250 12 6
L 1/1/05 8 378 292 12 6

26.Copy formula to cells D3 — D6.

Note that the Dominant Land Cover Class is (4) Deciduous Broadleaf Forests for all 5
years

A B C D
File aid Date Dominant Land Cover
LC_Type? _2001001_aid0001 aidd001 1/1/01 | (4) Deciduous Broadleaf Forests
LC_Type2_2002001_aid0001 | aidd001 1/1/02 (4) Deciduous Broadleaf Forests
LC_Type2 2003001 aid0001 aidd001 1/1/03  (4) Deciduous Broadleaf Forests
LC_Type2_2004001_aid0001 aiddd01 1/1/04 (4) Deciduous Broadleaf Forests
LC_TypeZ_2005001_aid0001 aid0001 1/1/05 (4) Deciduous Broadleaf Forests

Calculating Land Cover Dominance
(percentage of the area covered by the dominant class)

27.Insert a column after column D (Dominant Land Cover Class) and label it Dominant
Class Percentage
28.1n cell E2, type the following formula: =MAX(F2:J2)/SUM(F2:J2)*100.

fx| =MAX(F2:)2)/SUM(F2:)2)*100|

L
L
L
L
L

29.Copy the equation to cells E3 — E6.
30. Note that the Dominant Class Percentage is around 54% for each of the years
analyzed.
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Date Dominant Land Cover Dominant Class Percentage (0) Water Bodies (4) Deciduous Broadleaf Forests (5) Mixed Forests (8) Woody Savannas  (13) Urban and Built-up Lands
1/1/01 (4) Deciduous Broadleaf Forests [=MAX({F2:J2)/SUM(F2:J2)* 100 [ 8 378 295 g )
1/1/02 (4) Deciduous Broadleaf Forests 8 379 291 12 6
1/1/03 (4) Deciduous Broadleaf Forests B 377 253 12 6
1/1/04 (4) Deciduous Broadleaf Forests 8 380 250 12 6
1/1/05 (4) Deciduous Broadleaf Forests 8 378 292 12 6
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Sw— D | E

Date Daominant Land Cover Dominant Class Percentage
1/1/01 (4) Deciduous Broadleaf Forests 5431034483
1/1/02 (4) Deciduous Broadleaf Forests 5445402299
1/1/03 (4) Deciduous Broadleaf Forests 54. 16666667
1/1/04 (4) Deciduous Broadleaf Forests 5459770115
1/1/05 (4) Deciduous Broadleaf Forests 54.31034483

Calculating Land Cover Richness
(total number of classes within the 10 km polygon)

31.Insert a new column after column E (Dominant class percentage) and label it
Number of Classes.
32.In Cell F2, type the following formula: =COUNT(G2:K2)

fx| =COUNT(G2:K2)

; C D E | F |
Date Dominant Land Cover Dominant Class Percentage Number of Classes [

51 1/1/01 (4) Deciduous Broadleaf Forests 54.31034483 |=COUNT{G2:K2) [

11 1/1/02 (4) Deciduous Broadleaf Forests 3445402299 Ji

11 1/1/03 (4) Deciduous Broadleaf Forests 54, 16666667

11 1/1/04 (4) Deciduous Broadleaf Forests 54539770115

i1 1/1/05 (4) Deciduous Broadleaf Forests 5431034483

Copy to cells F3 — F6.

e Note there are 5 classes in this polygon for each year
e Save the file as Landcover.xIsx

Next we will calculate the topographic variability

Open the SRTMGL1-003-Statistics.csv file in Microsoft Excel
33.In Cell Q1, type “Coefficient of Variation”
e The coefficient of variation, the ratio of the standard deviation to the mean,
measures the variability of the data in relation to the mean
34.1n Cell Q2, calculate CV (take the standard deviation divided by the mean multiplied
by 100). Type in this equation: =J2/12*100
35.Save the file as Topo_Var.xlsx

Next, we will calculate variables for vegetation dynamics. This includes total annual
productivity, minimum level of perennial cover, and degree of vegetation seasonality.
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Total Annual Productivity

36.0pen the MOD17A3-055-Statistics.csv file in Microsoft Excel

37.1n Cell C7, type the ID for this grid cell: 17QK09

38.In cell D7, type 2001-2005

39.1n cell 17, calculate the Mean NPP for the 5 years: =AVERAGE(I2:16)
40. Save the file as NPP.xIsx

A B C D E E G H 1

File Name Dataset aid Date Count Minimum  Maximum  Range fean
MOD17A3_055_Npp_lkm_doy2001001_aid0001 Npp_lkm  aid0001 1/1/01 159 0.1214 0.5856 (0.1214,0.58 0.4553
MOD17A3_055_Npp_lkm_doy2002001_aid0001 Npp_lkm  aid0001 1/1/02 159 0.1668 0.6104 (0.1668,0.61 0.4849
MOD17A3_055_Npp_lkm_doy2003001_aid0001 Npp_lkm  aid0001 1/1/03 155 0.1802 0.7106 (0.1802,0.71 0.6003
MOD17A3_055_Npp_lkm_doy2004001_aid0001 Npp_lkm  aid0001 1/1/04 159 0.1866 0.7831 (0.1866,0.78 0.7104
MOD17A3_055_Npp_lkm_doy2005001_aid0001 Npp_lkm  aid0001 1/1/05 159 0.1657 0.639 (0.1657,0.63 0.5211
170K09 2001-2005 0.5552

Minimum Level of Perennial Cover
(minimum NDVI)

41.0pen the MOD13A3-006-Statistics csv file
42.In cell R2, type Minimum Annual NDVI
43.1n cells S1-W1, type 2001,2002, 2003, 2004, 2005
44.In cells S2-W2, put the minimum NDVI value for each year. Find the lowest value in
Column F (Minimum) for each year (column D). For example, The value for cell S2
(2001) will be 0.0098.
e One way to complete this step is to use the MIN equation option and select all
the minimum values from that year to find the lowest of the minimum values.
For example, in cell S2 type: =MIN(F2:F13) and in cell T2 type:
=MIN(F14:F25), and continue this process with the remaining cells U2 to W2.
45.In cell X1, type 5 Year Mean. In cell X2, calculate the mean annual minimum NDVI
for the 5 year period: =ZAVERAGE(S2:W?2)

R s T V] v W X

Minimum Annual NDVI 2001 2002 2003 2004 2005 5 Year Min
¥ ooose” 00056 o00031"  oo00837  0.0056 0.00424

Degree of Vegetation Seasonality
(coefficient of variation of NDVI values) for each year

46.In cell Q1, type CV
47.1n cell Q2 calculate the coefficient of variation for 1 January 2001: =J2/12*100. Copy
that formula to cells Q3 through Q61
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48.In cell R3, type “Mean CV”

49.In cells S3-W3, calculate the mean CV for each year. For example in cell S3 put
=AVERAGE (Q2:Q13)

50.Calculate the mean CV over the 5 years. In cell X3 put =AVERAGE(S3:W3)

51.Save the csv file as NDVI.xIsx

Q R S T U v W X
oV Minimum Annual NDVI 2001 2002 2003 2004 2005 5 Year Min
52.973342 " o0.0098” 00056  0.0031" 0.0083"  0.0056  0.00424
45.196003 Mean CV 18.826605 20.783281 19.355199  19.05685 17.843496
56.975773

12.657469

8.7608069

3.8599856

As we have found using AppEEARS and some quick analysis in Excel, the
environmental descriptors for the OBBA tile are:

e Dominant Land Cover Class: (4) Deciduous Broadleaf Forests
e Land Cover Dominance: 54.37%

e LCT Richness: 5 (land cover classes present in tile)

e Topographic Coefficient of Variation: 8.544516163

e Total Annual Productivity (NPP): 0.5552 kg C/m?

e Minimum Level of Perennial Cover (NDVI): 0.00424

e Degree of Vegetation Seasonality (CV): 19.17308619

These variables, as noted in Coops et al., 2009, can be used to help explain the
variance in bird species in this region. Through a combination of these remotely-sensed
variables and in-situ information, species richness information can be gathered for
future modeling studies or conservation planning.

Conclusion

The investigation of vegetation health over time can be used to examine forest
disturbance, agricultural productivity, wildfires, and urban development. Additionally, the
combination of multiple remotely sensed data layers over time can be an important
technique for monitoring ecosystem variables and species richness. In this exercise, we
used the AppEEARS tool to first investigate multiple points in the forests of the
Colorado Rockies to identify tree mortality associated with mountain pine beetle
infestation. The AppEEARS tool allows users to quickly investigate graphs of MODIS
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NDVI values across multiple years for multiple points. In the second part of this
exercise, we used the polygon option in AppEEARS and multiple datasets such as land
cover and NPP to investigate metrics related to species richness of birds.

Additional Resources

AppEEARS Documentation: https://I[pdaacsvc.cr.usgs.gov/appeears/help

Coops, N., M.A. Wulder, D. lwanicka. 2009. Exploring the relative importance of
satellite-derived descriptors of production, topography and land cover for predicting
breeding bird species richness over Ontario, Canada, Remote Sensing of Environment:
v. 113 pp. 668-679.
https://www.sciencedirect.com/science/article/pii/S0034425708003465

Ontario Breeding Bird Atlas (OBBA) project: http://birdsontario.org/atlas/.
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